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About NetCD NetCD is a CD player utility for the Mac OS. NetCD can retrieve CD information from the

CDDB internet database or from user input and can store information on the hard disk

in the CD Remote Programs file, the same file used by Apple’s CD Remote and AppleCD

Audio Player utilities. NetCD is System 7 and OS 8 compatible, Appearance Manager

compliant, supports Balloon Help and Contextual Menus, and works with both ATAPI

and non-ATAPI CD-ROM drives.

Requirements To use NetCD, you must have a Mac OS Computer with a 68040 processor or better and a

CD-ROM drive. To use the internet features, you must have Open Transport installed on
your computer with either a modem or a direct internet connection. Because I am not
able to forsee every possible combination of CD-ROM drives, computers and system
software, your results may vary.

Installing NetCD If you have received NetCD as a compressed archive, double-click the archive to

decompress the program. If you would like NetCD to appear in your Apple menu, place
the program or an alias to it in the Apple Menu Items folder in your System folder.

CD Remote Programs When NetCD is set to record CD program information to your hard disk, it places this 

and NetCD Extra Data information in a file called CD Remote Programs. This file is located in the Preferences
folder in your System folder. CD Remote Programs is used by other audio CD programs
such as CD Remote and AppleCD Audio Player. If you have entered other CD
information using these programs, you might want to make a backup copy of this file
before using NetCD.

NetCD also uses a second file in your preferences folder, NetCD Extra Data, to store extra
information about the disc and individual tracks. This file is not use by other programs
such as AppleCD Audio Player.

Modem Connections If you use a modem to connect to the internet, you must have Open Transport and a

PPP or SLIP connection to use NetCD. These protocols create a virtual “direct
connection” to the internet over your modem. As with most internet-based programs
on the Macintosh, NetCD will automatically start your PPP or SLIP connection when it
needs to connect to the internet. Like other programs, it does not terminate the
connection when done, but leaves it open for subsequent use.



Starting NetCD To use NetCD, double-click on the program’s icon. If you have placed NetCD or an alias 

 for the First Time to it in the Apple Menu Items folder, you can start NetCD by choosing it from the Apple

Menu.

Figure 1: The Preferences Dialog Box.

When you open NetCD for the first time, the Preferences dialog box appears. Before
using NetCD, you must decide when you want NetCD to connect to the internet, and
provide it with some information concerning the connection.

1. Choose when you want to connect to the internet. NetCD allows you to specify the
circumstances under which the program should connect to the internet to retrieve CD
information. You can choose one of the options on the left side of the preferences
dialog box, each of which is described below:

Never. If you select Never, NetCD will not connect to the internet for CD
information. Use this option if you do not have an internet connection, or do
not wish to use NetCD’s internet capabilities.

Only On Command. If you select this option, the Connect button in the main
window will be enabled and NetCD will download CD information from the
internet only when you click the Connect button.

Only For Unknown Discs. If you select this option, NetCD will always check the
CD Remote Programs file first to identify a CD. If there is no information in that
file for the CD, NetCD will retrieve information from the internet and display it.



Always. If you select Always, NetCD will download information from the
internet for every disc, even if that disc has been played previously.

If you choose one of the last three options, you can specify whether or not you want to
save the information NetCD downloads from the internet to your CD Remote Programs
file. If you want to save this information, make sure Save Downloaded Information is
checked. If you do not wish to save the information from the internet servers, make
sure Save Downloaded Information is not checked.

If you chose Never in step 1, you can skip steps 2 and 3, since they apply only to internet
connections.

2. Choose a CDDB server. NetCD connects to a CDDB server to retrieve CD program
information. There are CDDB servers all over the world, with new ones added
periodically. To choose a server, click Select New Server.

When you click Select New Server, NetCD opens the internet connection and downloads
the current list of servers from which you can choose.  After it has retrieved this list,
NetCD displays the list in a separate dialog box. Select a server that is geographically near
your location and click OK. The location of the new server is displayed above the Select
New Server button.

3. Enter your e-mail address. When NetCD connects to the CDDB server, it needs to
submit your e-mail address to log in. Your e-mail address is kept completely private and
is used only as identification, and it helps the people who operate the CDDB servers
know better who is using this free service.

4. Click OK to confirm your choices. If you missed a step, NetCD will ask you to make the
required choice. Once you click OK, your preferences are saved and you will not need to
enter your preferences again unless you wish to change them.

As an example, on my computer at work, where I have a direct connection to the
internet, I use Only For Unknown Discs and Save Downloaded Information. This way,
when NetCD finds a disc it does not recognize, it quietly checks the internet for the
information and saves it so it doesn’t have to check it again.  On my home computer,
where I use a modem to connect to the internet, I use Only On Command, so that
NetCD doesn’t tie up the phone line without my permission. (Hmm... how about
NetTeenager?)



The Main Window NetCD’s main window is shown in figure 2. Since NetCD is Appearance Manager-
compliant, the colors of the controls and window may be different depending on the
appearance settings for your computer.

If you do not see the whole window, click the zoom button to the right of the time
display to show the lower part of the window. The controls in the window are explained
below.

Figure 2: NetCD’s Main Window.

CD Buttons. The seven buttons in the upper left hand corner of the window control the playback of
the audio CD. Clockwise from the top left, they are:

Play/Pause. This button plays the CD. When the CD is playing, this button
becomes the Pause button, which pauses the CD.
Stop.  This button stops the CD playback.
Eject. This button ejects the CD from the CD-ROM drive. To open the CD-ROM
tray when no disc is in the drive, press the eject button on the drive itself. 



Forward Scan. Clicking and holding down this button moves forward rapidly
through the disc.
Backward Scan. Cliching and holding down this button moves backward
rapidly through the disc.
Next Track. This button begins playback at the beginning of the next track.
Previous Track. This button begins playback at the beginning of the previous
track.

CD Title Field. The title of the CD is displayed in the upper right hand corner of the window. If it is too
long to be displayed, only the first part is shown, followed by ellipsis (…).

Track Popup Menu. The tracks of the CD are listed both numerically and by title in the popup window below
the disc name. When closed, this popup menu shows the number of the track currently
playing. When you open the menu by clicking on it, the numbers and titles of all the
tracks are displayed. The currently playing track is selected. To begin playback at a
specific track, choose the track from this popup menu.

Time Display. The time display is to the right of the track popup menu. By default, the display shows
the elapsed time, in minutes and seconds, for the current track. The display can be set
to show other information through the Display menu, which will be discussed later.

Zoom Button. The zoom button, located to the right of the time display, toggled between compact
view and expanded view. To switch views, click the button.

Title and Track Fields. In expanded view, the disc title and track titles are displayed in the edit fields in the
middle of the window.  These fields display the program information for the current CD
and can be changed by the user. To move between the fields, press the tab key or the
return key. You can use the standard edit functions (cut, copy, paste) in these fields. If
there are more than eleven tracks on the CD, you can use the scroll bar to the right to
view the titles of the other tracks.

The Connect Button. The connect button at the bottom of the window allows you to connect to the internet
to retrieve CD information. While NetCD is connecting to a CDDB server, this button
becomes the Cancel button, which, when clicked, will cancel the current internet
connection. This button may be dimmed according to your connection preferences,
which will be discussed later.

The Resize Box. The resize box is located at the lower right-hand corner of the window. To change the
width of the window, click on the resize box and drag it to the left or right. When you let
go, the window and its controls change to the new width.



NetCD’s Menus Nearly all of NetCD’s functions are available through the main window, but some of

NetCD’s features are available through the menus as well, which are explained below.

The Apple Menu. In addition to the items you have placed in the Apple Menu Items folder, the Apple
Menu contains two menu items:

About NetCD. This command displays a box describing NetCD.
About CDDB.  This command displays a box describing the CDDB service.

The File Menu The File Menu has only one menu item, Quit, which closes the NetCD program. Quitting
the program does not stop the CD. You can also quit NetCD by clicking the main
window’s close box at the left end of the title bar.

The Edit Menu The Edit Menu contains the standard Edit commands for the Macintosh. For more
information on these commands, consult the documentation that came with your
computer.

The NetCD Menu The NetCD Menu contains  a few commands specific to NetCD:

Play/Pause. This command changes depending on whether the CD is playing or
stopped. It’s effect is the same as pressing the Play/Pause button.
Stop.  This command has the same effect as pressing the Stop button.
Eject. This command has the same effect as pressing the Eject button.
Display. The Display submenu allows you to change the time display in the
main window. The current choice is marked with a check mark.
Show Information. This command displays the extra information window,
which displays any extended information about the current CD. At the bottom
of the window is a popup menu from which you can choose the information
you wish to view. Information downloaded from the CDDB is displayed in this
window, and any changes or additions made are saved to your local CD
database. When the extra information window is visible, the menu item
switches to Hide Information. 
Preferences… This command displays the Preferences dialog box, where you
can view and change your connection preferences.

Contextual Menus In addition to the menus in the menubar, you can access a contextual menu at any time
by holding the Control key and clicking the mouse in the NetCD main window. From the
contextual menu you can change the time display or access the connection preferences.



CDDB Submission If NetCD searches the internet database for your CD and doesn’t find a match, it will give

you the option of sending information about the CD to add to the internet database. All
information in the CDDB has been entered by users like you. The CDDB submission can
include all of the following information:

· Disc Artist and Title. These two items are entered into separate fields in the Submit
Information dialog box, and are displayed in the main CD window separated by a slash
(“They Might Be Giants / Factory Showroom”, for example).

· Track Titles.
· Extended Information. This is the information made visible by selecting “Show

Information” from the NetCD menu.

If you do not wish to submit CD information to the CDDB, click the Cancel button in the
Submit Information dialog box. If you do wish to send information to the CDDB, enter
the information into the fields and click the Send button. NetCD will submit the
information to the server. If it is rejected for some reason, you will receive an e-mail
message explaining why.

Please remember that the CDDB is a free service provided to everyone. With this in mind,
please observe the following guidelines when submitting CD information to the
database:

· Do not submit information for homemade compilation CDs or other unique discs.
Since no one else is able to take advantage of this information, these submissions
simply clutter the database needlessly.

· Feel free to use accented characters where appropriate. For instance: “André Previn and
Orchestre Révolutionnaire et Romantique / The Music of Henryk Górecki and Arvo
Pärt” (Though I’m quite certain we won’t be seeing this CD anytime soon...)

· Take advantage of the extra information fields. Some users use this feature to include
lyrics, libretti, performance information or other pertinent data. Please avoid personal
opinions or experience, however.

· Make sure each track has a title. If the CD does not list a title for the track and you do
not know it, use “[Untitled].”

· If the CD has more than one artist, use the phrase “Various Artists” for the artist field
and include the artist for each track in the extra information field for that track.

· Use appropriate capitalization. In most cases, the capitalization used on the CD case is
fine. Do not use all capitals, however; if the CD case does, use proper song title
capitalization (which means capitalizing every word, as in “I Wouldn’t Normally Do This
Kind Of Thing”).

· Proofread your submission for spelling errors and correct track numbers.



Jacket Notes I am indebted to all the individuals who made this program possible, most especially

Andrew Barry, Geoff Perlman, Jason Parsley, Ti Kan, Steve Scherf, Guillaume Grenier and
Bob Blank. 

NetCD is freeware and may be distributed freely as long as all documentation is included.
NetCD may not be sold for profit under any circumstances. Toby W. Rush assumes no
responsibility for any damage or loss of data incurred by this program or its use.


